8 October 2005

9 Web Site Mini-Guide:
Undeliverable E-Malil

When you send a newsletter or on-line course using CourseBot, you will invariably
receive some notices about undeliverable e- mail. This guide takes you through the
process of capturing and managing those notices.

Introduction

Everybody who manages a mailing list has to deal with the problem of
undeliverable e- mail — also known as “bounced” e-mail. The Internet’s e- mail
system is reasonably good, because it usually informs you of these failures. But
then it's your responsibility to manage these e-mail addresses.

Undeliverable e- mail falls into a number of categories, depending on the reason it

was undeliverable:

1.

Courtesy messages: The recipient is out of the office for some time, so they set
up their e- mail program to send you a polite reply automatically. You can ignore
these messages.

Delay warnings: If the Internet cannot deliver its e-mail immediately, but thinks
it has a reasonable chance of delivering it later, it sends you a warning
message, informing you of the delay. Again, you can ignore these messages.

Content failure: If your e- mail is blocked because of its content (in other words,
it’s been blocked by a spam filter or corporate firewall), you sometimes get
back a failure message. You usually ignore this message, because you hope that
the next message won’t be blocked in the same way.

“Soft bounces”: You receive a failure message if the Internet is unable to deliver
the e-mail for some other temporary reason — such as a full mailbox, or some
temporary access problems. In this case, you can usually ignore the problem,
hoping it will correct itself next time. However, if the problem persists, see a
doctor ... err, no, it might be a permanent failure.

“Hard bounces”: You receive a failure message if there’s a permanent problem —
such as the closure of the account, mis-typed address or mailbox disabled. In
this case, you might as well remove the e-mail address from your mailing list
immediately, because it will never work again.

Because of all these variations, it’'s not a trivial matter to handle all your
undeliverable e- mail yourself — especially as your mailing list grows. That’s why
CourseBot includes some special software to help you manage this mail.

Broadly, you manage the undeliverable e- mail like this:
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Gather up all the failure messages in your e-mail program.
Upload them to CourseBot for processing.

CourseBot reads them, classifies them according to their severity, and shows
you a list of e-mail addresses it recommends that you remove.

You confirm these recommendations, or make changes of your own.
You manually delete any other addresses that CourseBot couldn’t manage.

The rest of this user guide goes through these processes in detail.

Capturing undeliverable e-mail

The first step in the process is to gather up all the undeliverable e-mail in one
place. If you've just been collecting it in your in-box, that’s not the most
appropriate place for it. Instead, you can create an automatic rule in your e-mail
program so that it recognises these failure messages and files them away
automatically in a special place.

We’re going to demonstrate how to do that using Microsoft Outlook. If you’re using
other e-mail software, you’ll have to figure out how to do this yourself by adapting
these instructions.

Start by creating a new folder — e.g. “Subscriptions” — in Outlook for the failure
messages.

Then open the Rules Wizard from the Tools menu:

Tools | Ackions  Help

SendiReceive 3

Send/Receive Settings 3
Address Book,..  Chrl+3hift+6
23 Find Chl+E

Adwvanced Find...  Chrl+5Shift+F 1

5 )
& Rules Wizard. ..

Mailboy Cleanup...

{2 Empty "Deleted Items" Folder

Click the New button to create a new rule:

Rules Wizard

Apply changes to this Folder:

|Inhox [First Skep, E-Setvice, Personal E-Mail, Dialix, ArachMet, E-Zine Subs-ﬂ

Apply rules in the Following order:

(v courses@keithabraham | Mew
[v] wahoogroups, com i
|v| Exception List

[v] M3AA bounce

[v| Subscriptions (senders)
(v subscriptions {subjects)
[w] Sender whitelist

(v Subject whikelist |

Rename...

Delete

0
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We’ll now take you through the specific steps of creating the rule. To give you an
overview of the process, this is what you’ll end up with for the rule:

Rule description (click on an underlined value to edit it):

Apply Ehis rule afker the message arrives
itk in the recipient's address

and with in the subject
move it ko the Folder

and skop processing more rules

Follow the steps below to achieve this result ...

Create from template:

| Rules Wizard

(% Start creating a rule Fram a templake
™ Start From a blank rule

Mawve new messages from someone
Motify me when important messages arrive
! Move messages based on conkent

Turn off the “people or list” option, and turn on “specific words in subject”:
wehich candition(s) dio wau wank ko check?

[ From
[w#iwith specific words in the subject

Click the “specific words” link at the bottom of the page so that you can choose
the specific words:

Rule description (click on an undetlined walue to edit it);

Apply Ehis rule afker the message arrives
with specific wards in the subject
move it ko the Folder

Add the phrases “undelivered mail”, “returned mail” and “failure notice”, then
click OK:

Search Text @

Specify words or phrases bo search for in the subject:

Failure notice| add

Search lisk:

"undeliverad mail" ar
"returned mail"

[

oK | Zancel |

Scroll down the list of options at the top and click the “specific words in the
recipient’s address” option:

E with ir the mes;sage header
[w]iwith specific words in the recipient’s address
g with in the sender's address
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Again, click “specific words” in the bottom area to open the window:

Rule description (click on an undetlined walue to edik it

Apply this rule after the message arrives

with specific waords in the recipient's address
and with

move it ko the Folder

This time, add the words “webmaster” and “eservice@arthur”, then click OK and
Next.

Search Text

Specify a word or phrase ko search For in the recipient's address:

||
[ e

Search lisk:

"webmaster” or
"eservice@arthur"

Ok | Cancel |

Click “specified” in the bottom area so that you can choose where to file this e-
mail:

Rule description (click on an underlined wvalue to edit it):

apply this rule after the message arrives

with in the recipient's ad:
and with

move it ko the Epecifiedifolder

This shows you a list of e-mail folders. Choose the new folder that you created

earlier:
Rules Wizard
Choose a folder:
@ Drafts ~| oK |
=1 Inbo
@ AAA Suspicious Cancel

+-%E Action - Pending
+ ﬂﬁ Action - Projects
+-4 FAQ Replies
+-53 Filing

M,

Mokes
&5 outbox [w]

Finally, as a precaution, click the link to stop any more rules:

E run
|w*|istop processing more rules
[ perfarmm

Then give this rule a name and click “Finish”.
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That completes the process. Again, here is the final rule:

Rule descripkion (click on an undetlined value to edit it

Apply this rule after the message arrives
with in the recipient's address

and wikh in the subject
rnove it to the Folder

and stop processing more rules

Upload to CourseBot

The next time you send e-mail using CourseBot, you’ll receive the failure messages.
Most of them occur within a few minutes of sending the e-mail, though some take
considerably longer — even days.

You can upload them to CourseBot at any time. We recommend that you wait until
you’re confident that most of them have arrived, to save yourself the effort of doing

the process again later.

Save to disk

The first part of this process is to save the failure messages to disk. Again, we’re
going to demonstrate this using Microsoft Outlook; you’ll have to adapt this to suit
other e-mail programs.

Start by going to the folder where you’ve collected the undeliverable e-mail, and
check that it does only contain undeliverable e-mail. Remove any other
legitimate e-mail from this folder; otherwise CourseBot might accidentally remove
that sender’s e-mail address.

Then choose all the messages by using the Select All option in the Edit menu:

Subscriptions - Microsoft Outlook E]@
File | Edit | Wiew Favorites  Tools  Actions  Help -
_-jﬂ s WE Farward %Send,ﬂ?eg&ive Ed: - @ ’:

Cuk Chrl+
s
‘jg R Paste Chrl+
Faol x Look For; ~ Search In~ Subsc Find Now Options X
Th
* @ YO %@ From | Subject Received| Size J
=& # Delete o 1] i 1 0 post.. Delivery Status Motification (Failure)  Fri30f.,. SKB:
£ MarkasRead Chi+0 £ 0 post,.. Delivery Skatus Motification (Failure)  Fri30/... SKE
¥
74 Nalakad 1 ack Waals (174 J

From the File menu, choose “Save As”:

File | Edit ‘iew Favorites Toc

Mew 3
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and save the results in a text file somewhere — for example, in My Documents on a

PC:
Save ks 2JEd
e n; |'_|N,Do|:mm.s = £ ,_ﬂ':i W-‘.‘.r'"- Toaks =
I Carnkass Shedn
A, | LMy ebooks
Fistory ISy gt pader
iry e
v 2 My Fcbses
! Mry videos

My Docurenis | IO anes

o

Diazkbop
Farniices
l'*.:‘;'-— Pie name: h.hit - I
My Nekraatk l I Ak
Placas Samha s b pa: p’MW‘r e _ =] Carcal

Upload to the Web site

Log in to the E-Service administration area in the usual way. Scroll down to the
CourseBot area, and you’ll see these options for handling undeliverable e-mail:

Undeliverable E-mail

* Submit batch of undeliverable mail
+ YView status

You almost always use the first of these options, because you’ll be submitting a
batch of failure messages and processing them immediately (as we’ll describe
here). However, you can always go back in at any time and click “View status” to
see the failure messages that CourseBot still has pending for future processing.

For now, click the “Submit batch ...” link, which takes you to a page where you can
upload your file of failure messages.

Load file: |C\Documents and Sethir

Click the Browse button, find the saved file on your hard disk, choose it, then click
“Confirm” to upload it. Depending on the size of the file, this could take a while.

Classifying the messages

As it's uploading the file, CourseBot reads the messages to determine what each
one means. It discards warning and courtesy messages, and then classifies the
remaining messages according to their severity.

At the end of this process, CourseBot displays a list of potentially “broken” e-mail
addresses. The list is colour-coded to help you quickly see which addresses are to
be deleted.
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Here’s an example of such a list:

[ Process Bounced E-Mail ]

4+ errors

30+ days - Unknown

Date E-Mail Address I'll Handle Unsubscribe Ignore Ignore
This Myself This Address This Time Always

‘ Ignored ‘ 1-3 errors

2005/09/05 jenwong2@blah.com
- over quota

2005/09/05 blah@campus.co.nz

- delivery to the following recipients failed
2005/09/05 maria.blah@blah.com.au

- delivery to the following recipients failed (4
2005/09/05 cairns@blah. com.au

- delivery to the following recipients failed
2005/09/05 blahh@queenslanders.org. au

- delivery to the following recipients failed
2005/09/05 jeremy@blah.com.au

- delivery to the following recipients failed

T e L

(Note: For privacy reasons, all e- mail addresses in these examples have been
changed)

g O o O O
@@ O O @ O
g @ ©o o @
g O @ O O

Let’s look at some of these specifically:

This is a non-existent mailbox error, which is a permanent problem. CourseBot
earmarks this for immediate deletion:

This is a vague error message, but it’'s happened more than three times, so
CourseBot now marks it for deletion:

2005/09/05 maria.blah@blah.com. au
- delivery to the following recipients failed (4)

This is also a vague error message, and it’s recurred after more than 30 days,
so CourseBot now marks it for deletion:

2005/09/05 jeremy@blah.com.au
- delivery to the following recipients failed

This mailbox is full, which is a temporary problem only, so CourseBot ignores it
this time:

2005/09/05 jenwong2@blah.com
- awer quota

This is an address that would normally be marked for deletion, but we’ve
decided to manually preserve it by clicking in the “Ignore Always” column:

2005/09/05 cairns@blah, com, au
- delivery to the following recipients failed
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As you can see, CourseBot classifies each faillure message, and decides to process
it accordingly.

Take a quick look through the list, especially those items marked with a selection in
the “Unsubscribe This Address” column:

Date E-Mail Address I'll Handle Upé : Ignore Ignore

O
O
O

2005/09/05 jenwong2@blah.com O
- over guota

2005/09/05 blah@campus.co.nz
- delivery to the following recipients failed

2005/09,/058 maria.blah@hblah.cam. au
- delivery to the following recipients failed (4)

These e-mail addresses will be deleted by CourseBot, unless you choose otherwise.
If you do decide to keep an address, you can tick one of the other three columns:

I’'ll Handle This Myself: Use this to remove the failure message from
CourseBot’s list, as if you had never uploaded it.

Ignore This Time: Use this to keep a record of this failure, without removing
this address just yet. For example, if you suspect that a user’s e-mail account
has been closed temporarily, you might choose this option.

Ignore Always: Use this for addresses that keep getting returned, even

though you know the e-mail is getting through. This does happen, though it's

rare.
After you’'ve gone through the list in this way, click the “Process Bounced E-Mail”
button (there’s one at the top and the bottom of the list). This tells CourseBot to go
ahead and remove any bad e-mail addresses.

Manual processing

In general, you’ll find that CourseBot does a pretty good job of handling most of the
failure messages. However, you sometimes find that it reports some errors, like

this:

Unable to delete:

cpartonfmail. . blah.com.au
Jeremylblah.com. au
tracyiblah. wow.aust . com
blahfpacific.net.sg
maria.blahfblah. com. au
blahlprupartner . com.my
blah@blah.co.nz

[1'1l Bandle These Myself |

This usually happens when the user has their e- mail forwarded to a different
address. You get the failure message from the mail server at the final e-mail
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address, but CourseBot only knows about the original address, so it can’t delete the
e-mail address.

When this happens, you have to delete these e-mail addresses manually. If you still
have the failure messages in Microsoft Outlook, this is usually easy to do.

Do the following steps for each address:
Search for it in the Outlook folder where you saved the failure messages.

When you find the message, look for an attachment, which is the original
message sent to that person:

Frari: Mail Delivery System [MAILER-DAEMOMN@eftel com] Sent: Sat 17102005 4:04 PM
To: online@firststep. cam. au
o

Subject:  Undelivered Mail Returned ko S

Attachments: (2] details. bt (425 B B welcome Rob (4,64 KE).msg (9 KE)

Thi=s is the Postfix prDWl.com.

I'm sorry to have to inform you that your message could not he he
delivered to one or more recipients. It's attached helow.

If the attachment is there, open it and look for a “Manage subscription” (or
similar) link near the bottom of the page:

< Manage our Subscription E)ext Cnly, Change E-Mail, Unsubscribe)
#eoe | Privacy Policy

o
First Step Communications

Web sites that work ... GUARANTEED!

Click this link, and it will open a Web page where you can unsubscribe the user
from all mailing lists.

Sometimes there’s no attachment, but the original message is in the body of
the failure message, and contains this line:

<!=— If you can read this, click below to change to text format: —->
<!—— http://uyw.egervice. cow.aw/coursehot-manaye/firststep, 10542, 1196 —-—>

If you see this, click the link and it also takes you to the Manage Subscription
page.

If neither of these options applies, look around in the message for what might
have been the original e- mail address. Then, from the E-Service administration
page, click “Search for subscribers” and search for this address. From there, you
can remove the address from all mailing lists.

Occasionally, you’ll find that it’s impossible to find the original e- mail address. In
that case, you’ll just have to shrug your shoulders and put up with the

inconvenience. The next time you receive e-mail at this address, tick the “Ignore
Always” column.
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After you’ve finished processing these addresses manually, click the “I’'ll Handle
These Myself” link so that CourseBot knows to remove them from its list:

Unable to delete:

cpartonfmail. . blah.com.au
Jeremylblah.com. au
tracyiblah. wow.aust . com
blahfpacific.net.sg
maria.blahfblah. com. au
blahlprupartner . com.my
blah@blah.co.nz

I'll Handle These Myself
-r E=hel 1= ESE YSE T)

Clean-up

After processing the failure messages, go back to Outlook and delete them from
your folder.
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